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Chapter 1

Dialyzer User’s Guide

Dialyzer is a static analysis tool that identifies software discrepancies such as type errors, unreachable
code, unnecessary tests, etc in single Erlang modules or entire (sets of) applications.

1.1 Dialyzer

1.1.1 Introduction

Dialyzer is a static analysis tool that identifies software discrepancies such as type errors, unreachable
code, unnecessary tests, etc in single Erlang modules or entire (sets of) applications.

1.1.2 Using the Dialyzer from the GUI

Choosing the applications or modules

In the “File” window you will find a listing of the current directory. Click your way to the
directories/modules you want to add or type the correct path in the entry.

Mark the directories/modules you want to analyze for discrepancies and click “Add”. You can either add
the .beam and .erl-files directly, or you can add directories that contain these kinds of files. Note that
you are only allowed to add the type of files that can be analyzed in the current mode of operation (see
below), and that you cannot mix .beam and .erl-files.

The analysis modes

Dialyzer has two modes of analysis, “Byte Code” or “Source Code”. These are controlled by the buttons
in the top-middle part of the main window, under “Analysis Options”.
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Controlling the discrepancies reported by the Dialyzer

Under the “Warnings” pull-down menu, there are buttons that control which discrepancies are reported
to the user in the “Warnings” window. By clicking on these buttons, one can enable/disable a whole
class of warnings. Information about the classes of warnings can be found on the “Warnings” item under
the “Help” menu (at the rightmost top corner).

If modules are compiled with inlining, spurious warnings may be emitted. In the “Options” menu you
can choose to ignore inline-compiled modules when analyzing byte code. When starting from source
code this is not a problem since the inlining is explicitly turned off by Dialyzer. The option causes
Dialyzer to suppress all warnings from inline-compiled modules, since there is currently no way for
Dialyzer to find what parts of the code have been produced by inlining.

Running the analysis

Once you have chosen the modules or directories you want to analyze, click the “Run” button to start
the analysis. If for some reason you want to stop the analysis while it is running, push the “Stop” button.

The information from the analysis will be displayed in the Log and the Warnings windows.

Include directories and macro definitions

When analyzing from source you might have to supply Dialyzer with a list of include directories and
macro definitions (as you can do with the erlc flags -I and -D). This can be done either by starting
Dialyzer with these flags from the command line as in:

dialyzer -I my_includes -DDEBUG -Dvsn=42 -I one_more_dir

or by adding these explicitly using the “Manage Macro Definitions” or “Manage Include Directories”
sub-menus in the “Options” menu.

Saving the information on the Log and Warnings windows

In the “File” menu there are options to save the contents of the Log and the Warnings window. Just
choose the options and enter the file to save the contents in.

There are also buttons to clear the contents of each window.

Inspecting the inferred types of the analyzed functions

Dialyzer stores the information of the analyzed functions in a Persistent Lookup Table (PLT). After an
analysis you can inspect this information. In the PLT menu you can choose to either search the PLT or
inspect the contents of the whole PLT. The information is presented in edoc format.

1.1.3 Using the Dialyzer from the command line

See dialyzer(3) [page 6].

1.1.4 Using the Dialyzer from Erlang

See dialyzer(3) [page 6].
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1.1.5 More on the Persistent Lookup Table (PLT)

The persistent lookup table, or PLT, is used to store the result of an analysis. The PLT can then be used
as a starting point for later analyses. It is recommended to build a PLT with the otp applications that
you are using, but also to include your own applications that you are using frequently.

The PLT is built using the –build plt option to dialyzer. The following command builds the
recommended minimal PLT for OTP.

dialyzer --build_plt -r $ERL_TOP/lib/stdlib/ebin $ERL_TOP/lib/kernel/ebin $ERL_TOP/lib/mnesia/e

Dialyzer will look if there is an environment variable called $DIALZYER PLT and place the PLT at this
lokation. If no such variable is set, Dialyzer will place the PLT at $HOME/.dialyzer plt. The placement
can also be specified using the –plt, or –output plt options.

You can also add information to an existing plt using the –add to plt option. Suppose you want to also
include the compiler in the PLT and place it in a new PLT, then give the command

dialyzer --add_to_plt -r $ERL_TOP/lib/compiler/ebin --output_plt my.plt

Then you would like to add your favorite application my app to the new plt.

dialyzer --add_to_plt --plt my.plt -r my_app/ebin

But you realize that it is unnecessary to have compiler in this one.

dialyzer --remove_from_plt --plt my.plt -r $ERL_TOP/lib/compiler/ebin

Later, when you have fixed a bug in your application my app, you want to update the plt so that it will
be fresh the next time you run Dialyzer, run the command

dialyzer --check_plt --plt my.plt

Dialyzer will then reanalyze the files that have been changed, and the files that depend on these files.
Note that this consistency check will be performed automatically the next time you run Dialyzer with
this plt. The –check plt option is merely for doing so without doing any other analysis.

To get some information about a plt use the option

dialyzer --plt_info

You can also specify which plt with the –plt option, and get the output printed to a file with –output file

Note that when manipulating the plt, no warnings are emitted. To turn on warnings during (re)analysis
of the plt, use the option –get warnings.

1.1.6 Feedback and bug reports

At this point, we very much welcome user feedback (even wish-lists!). If you notice something weird,
especially if the Dialyzer reports any discrepancy that is a false positive, please send an error report
describing the symptoms and how to reproduce them to:

tobias.lindahl@it.uu.se, kostis@it.uu.se

3Dialyzer Application (DIALYZER)



Chapter 1: Dialyzer User’s Guide

4 Dialyzer Application (DIALYZER)



Dialyzer Reference Manual

Short Summaries

� Erlang Module dialyzer [page 6] – The Dialyzer, a DIscrepancy AnalYZer for
ERlang programs

dialyzer

The following functions are exported:

� gui() -> ok | ferror, Msgg
[page 8] Dialyzer GUI version

� gui(OptList) -> ok | ferror, Msgg
[page 8] Dialyzer GUI version

� run(OptList) -> Warnings
[page 9] Dialyzer command line version

� format warning(Msg) -> string()
[page 9] Get the string version of a warning message.

� plt info(string()) -> f’ok’, [fatom(), any()g]g | f’error’, atom()g
[page 9] Returns information about the specified plt.
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dialyzer
Erlang Module

The Dialyzer is a static analysis tool that identifies software discrepancies such as type
errors, unreachable code, unnecessary tests, etc in single Erlang modules or entire (sets
of) applications. Dialyzer starts its analysis from either debug-compiled BEAM bytecode
or from Erlang source code. The file and line number of a discrepancy is reported along
with an indication of what the discrepancy is about. Dialyzer bases its analysis on the
concept of success typings which allows for sound warnings (no false positives).

Read more about Dialyzer and about how to use it from the GUI in Dialyzer User’s
Guide [page 1].

Using the Dialyzer from the command line

Dialyzer also has a command line version for automated use. Below is a brief
description of the list of its options. The same information can be obtained by writing

dialyzer --help

in a shell. Please refer to the GUI description for more details on the operation of
Dialyzer.

The exit status of the command line version is:

0 - No problems were encountered during the analysis and no
warnings were emitted.

1 - Problems were encountered during the analysis.
2 - No problems were encountered, but warnings were emitted.

Usage:

dialyzer [--help] [--version] [--shell] [--quiet] [--verbose]
[-pa dir]* [--plt plt] [-Ddefine]* [-I include_dir]*
[--output_plt file] [-Wwarn]* [--src]
[-c applications] [-r applications] [-o outfile]
[--build_plt] [--add_to_plt] [--remove_from_plt] [--check_plt]
[--get_warnings]

Options:

-c applications(or --command-line applications) use Dialyzer from the
command line (no GUI) to detect defects in the specified applications (directories
or .erl or .beam files)

-r applications same as -c only that directories are searched recursively for
subdirectories containing .erl or .beam files (depending on the type of analysis)

-o outfile(or --output outfile) when using Dialyzer from the command line, send
the analysis results in the specified outfile rather than in stdout
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--src overide the default, which is to analyze debug compiled BEAM bytecode, and
analyze starting from Erlang source code instead

--raw When using Dialyzer from the command line, output the raw analysis results
(Erlang terms) instead of the formatted result. The raw format is easier to
post-process (for instance, to filter warnings or to output HTML pages).

-Dname(or -Dname=value) when analyzing from source, pass the define to Dialyzer (**)

-I include dir when analyzing from source, pass the include dir to Dialyzer (**)

-pa dir Include dir in the path for Erlang. Useful when analyzing files that have
-include lib() directives.

--output plt file Store the plt at the specified location after building it.

--plt plt Use the specified plt as the initial plt.

-Wwarn a family of option which selectively turn on/off warnings. (for help on the
names of warnings use dialyzer -Whelp)

--shell do not disable the Erlang shell while running the GUI

--version (or -v) prints the Dialyzer version and some more information and exits

--help (or -h) prints this message and exits

--quiet (or -q) makes Dialyzer a bit more quiet

--verbose makes Dialyzer a bit more verbose

--check plt Only checks if the init plt is up to date and rebuilds it if this is not the
case

--no check plt Skip the plt check when running Dialyzer. Useful when working with
installed plts that never change.

--build plt The analysis starts from an empty plt and creates a new one from the files
specified with -c and -r. Only works for beam files. Use –plt or –output plt to
override the default plt location.

--add to plt The plt is extended to also include the files specified with -c and -r. Use
–plt to specify wich plt to start from, and –output plt to specify where to put the
plt. Note that the analysis might include files from the plt if they depend on the
new files. This option only works with beam files.

--remove from plt The information from the files specified with -c and -r is removed
from the plt. Note that this may cause a re-analysis of the remaining dependent
files.

--get warnings Makes Dialyzer emit warnings even when manipulating the plt. Only
emits warnings for files that are actually analyzed. The default is to not emit any
warnings when manipulating the plt. This option has no effect when performing a
normal analysis.

Note:
* denotes that multiple occurrences of these options are possible.

** options -D and -I work both from command-line and in the Dialyzer GUI; the
syntax of defines and includes is the same as that used by erlc.

Warning options:
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-Wno return Suppress warnings for functions of no return.

-Wno unused Suppress warnings for unused functions.

-Wno improper lists Suppress warnings for construction of improper lists.

-Wno fun app Suppress warnings for fun applications that will fail.

-Wno match Suppress warnings for pattern matching operations that will never succeed.

-Werror handling*** Include warnings for functions that only return by means of an
exception.

-Wunmatched returns*** Include warnings for function calls which ignore the return
value(s).

-Wunderspecs*** Warn about underspecified functions (the -spec is strictly more
allowing than the success typing)

-Woverspecs*** Warn about overspecified functions (the -spec is strictly less allowing
than the success typing)

-Wspecdiffs*** Warn when the -spec is different than the success typing

Note:
*** These are options that turn on warnings rather than turning them off.

Using the Dialyzer from Erlang

You can also use Dialyzer directly from Erlang. Both the gui and the command line
version is available. The options are similar to the ones given from the command line, so
please refer to the sections above for a description of these.

Exports

gui() -> ok | ferror, Msgg

gui(OptList) -> ok | ferror, Msgg

Types:

� OptList – see below

Dialyzer GUI version.

OptList : [Option]
Option : {files, [Filename : string()]}

| {files_rec, [DirName : string()]}
| {defines, [{Macro: atom(), Value : term()}]}
| {from, src_code | byte_code} %% Defaults to byte_code
| {init_plt, FileName : string()} %% If changed from default
| {include_dirs, [DirName : string()]}
| {output_file, FileName : string()}
| {output_plt, FileName :: string()}
| {analysis_type, ’success_typings’ | ’plt_add’ | ’plt_build’ | ’plt_check’ | ’pl
| {warnings, [WarnOpts]}
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| {get_warnings, bool()}

WarnOpts : no_return
| no_unused
| no_improper_lists
| no_fun_app
| no_match
| no_fail_call
| error_handling
| unmatched_returns
| overspecs
| underspecs
| specdiffs

run(OptList) -> Warnings

Types:

� OptList – see gui/0,1
� Warnings – see below

Dialyzer command line version.

Warnings :: [{Tag, Id, Msg}]
Tag : ’warn_return_no_exit’ | ’warn_return_only_exit’

| ’warn_not_called’ | ’warn_non_proper_list’
| ’warn_fun_app’ | ’warn_matching’
| ’warn_failing_call’ | ’warn_contract_types’
| ’warn_contract_syntax’ | ’warn_contract_not_equal’
| ’warn_contract_subtype’ | ’warn_contract_supertype’

Id = {File :: string(), Line :: integer()}
Msg = msg() -- Undefined

format warning(Msg) -> string()

Types:

� Msg = fTag, Id, msg()g – See run/1

Get a string from warnings as returned by dialyzer:run/1.

plt info(string()) -> f’ok’, [fatom(), any()g]g | f’error’, atom()g

Returns information about the specified plt.
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Index of Modules and Functions

Modules are typed in this way.
Functions are typed in this way.

dialyzer
format_warning/1, 9
gui/0, 8
gui/1, 8
plt_info/1, 9
run/1, 9

format_warning/1
dialyzer , 9

gui/0
dialyzer , 8

gui/1
dialyzer , 8

plt_info/1
dialyzer , 9

run/1
dialyzer , 9
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